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1. Introducción

Introducción
Introducción a Minitab 19 para Windows ofrece una introducción a las características y tareas utilizadas con mayor
frecuencia en Minitab.

La mayoría de los análisis estadísticos requieren que se complete una serie de pasos, con frecuencia orientados por un
conocimiento previo o por el área de estudio que se investiga. Los capítulos 2 a 5 ilustran los siguientes pasos:

• Explorar datos con gráficos y presentar resultados

• Realizar análisis estadísticos

• Evaluar la calidad

• Diseñar un experimento

En los capítulos 6 y 7 aprenderá a hacer lo siguiente:

• Utilizar teclas de acceso rápido para automatizar los análisis futuros

• Importar datos a Minitab desde diferentes tipos de archivos y preparar los datos para análisis

La historia
Una empresa de libros por Internet tiene tres centros de envío regionales. Cada uno de los centros de envío utiliza un
sistema informático distinto para introducir y procesar los pedidos. La empresa quiere identificar qué sistema informático
es el más eficiente para usarlo en los tres centros de envío.

A lo largo de Introducción a Minitab 19 para Windows, usted analizará los datos procedentes de los centros de envío al
tiempo que aprende a usar Minitab. Creará gráficos y realizará análisis estadísticos para identificar cuál de los centros
de envío tiene el sistema informático más eficiente. A continuación, se centrará en los datos de ese centro de envío. En
primer lugar, creará gráficos de control para probar si el proceso de envío del centro está bajo control. A continuación,
realizará un análisis de capacidad para ver si el proceso está dentro de los límites de las especificaciones. Por último,
llevará a cabo un experimento para determinar de qué modo se pueden mejorar dichos procesos.

También aprenderá a usar comandos de sesión para automatizar análisis futuros y a importar datos a Minitab.

La interfaz de usuario de Minitab
Todo lo que usted ve en la interfaz de Minitab es parte de su proyecto.
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La interfaz de Minitab incluye los siguientes componentes:

1: Navigator
Contiene la lista de títulos de salida de su proyecto, ordenados del más antiguo al más reciente, con los títulos de
salida más recientes ubicados en la parte inferior de la lista. Haga clic con el botón derecho en cualquier título de
salida en el Navegador para realizar las siguientes tareas:

• Abrir la salida en el modo de vista dividida para compararla con la salida de una pestaña diferente.

• Cambiar el nombre de la salida. Cuando cambia el nombre de la salida, el nombre se actualiza en el panel de
salida.

• Enviar la salida a otra aplicación, como Word, PowerPoint o Companion by Minitab.

• Eliminar el análisis del proyecto. Esta acción se puede deshacer en el menú Edit.

Consejo: Si su proyecto incluye múltiples hojas de trabajo, puede ver la lista de salida por hoja de trabajo. En Navigator, haga clic en
 y seleccione Group Commands by Worksheet

2: Panel de salida
Muestra la salida, como gráficos y tablas, después de ejecutar un análisis. La salida correspondiente a cada análisis
se muestra en una sola pestaña. Puede realizar las siguientes tareas desde el panel de salida:

• Para afectar el contenido de una pestaña, haga clic en la pestaña y luego haga clic  al lado del título de la
salida.

• Para afectar una tabla o gráfico específico, haga clic en el gráfico o la tabla y luego haga clic en .
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• Para ver el resultado que no está visible actualmente, haga clic en el título de la salida en el Navigator.

Consejo: Para comparar los resultados de dos análisis diferentes, haga clic en el segundo elemento de la salida en el Navigator y
seleccione Open in Split View.

3: Panel de datos (hojas de trabajo)
Muestra la hoja de trabajo activa. Puede tener abiertas múltiples hojas de trabajo en el panel de datos al mismo
tiempo; sin embargo, Minitab utiliza los datos de la hoja de trabajo activa para ejecutar el análisis.
Consejo: Para cambiar el nombre de una hoja de trabajo, haga doble clic en el nombre de la pestaña de hoja de trabajo.

4: Panel de línea de comandos/historial
De forma predeterminada, este panel no se muestra. Para mostrar este panel, seleccione View > Command
Line/History. Si cierra Minitab mientras el panel está visible, el panel estará visible la próxima vez que abra Minitab.

Command Line
El lugar donde puede introducir o pegar lenguaje de comandos para realizar un análisis.

History
El lenguaje de comandos que Minitab utiliza para ejecutar un análisis. Puede seleccionar y copiar comandos
y subcomandos del panel History al panel Command Line, donde puede editarlos y volver a ejecutarlos.

5: Barra de estado
Utilice la barra de estado para mostrar u ocultar el Navegador, el panel de datos o el panel de salida. También
puede ampliar o reducir un gráfico o una hoja de trabajo, dependiendo de si está seleccionado el panel de datos
o el panel de salida.

• Haga clic en  para mostrar u ocultar el Navigator.

• Haga clic en  para mostrar el panel de salida y el panel de datos al mismo tiempo.

• Haga clic en  para mostrar el panel de datos solamente.

• Haga clic en  para mostrar el panel de salida solamente.

Tipos de datos
Una hoja de trabajo puede incluir los siguientes tipos de datos.

Datos numéricos
Números como 264 o 5,28125.

Datos de texto
Letras, números, espacios y caracteres especiales, como por ejemplo Prueba n.º 4 o Norteamérica.

Datos de fecha/hora
Fechas, como por ejemplo Mar-17-2019, 17-mar-2019, 3/17/19 o 17/03/19.

Horas, como por ejemplo 08:25:22 AM.

Fecha/hora, como por ejemplo 3/17/19 08:25:22 AM o 17/03/19 08:25:22.
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Abrir y examinar una hoja de trabajo
Puede abrir una nueva hoja de trabajo vacía en cualquier momento. También puede abrir uno o varios archivos con
datos, como un archivo de Microsoft Excel. Al abrir un archivo se copia el contenido de dicho archivo en el proyecto
actual de Minitab. Los cambios que realice en la hoja de trabajo mientras se encuentre en el proyecto no afectan al
archivo original.

Los datos de los tres centros de envío están guardados en la hoja de trabajo, ShippingData.MTW.

Nota: En algunos casos, será necesario preparar la hoja de trabajo antes de empezar un análisis. Para obtener más información, vaya a
Importación y preparación de datos en la página 56.

1. Abra los datos de muestra, ShippingData.MTW.

Los datos están dispuestos en columnas, que también se denominan variables. El número y el nombre de la columna
aparecen en la parte superior de cada columna.

C6C5-TC4C3-DC2-DC1-T

DistanciaEstadoDíasLlegadaPedidoCentro

255A tiempo4,282643/8 15:213/4 8:34Este1

196A tiempo3,354173/7 17:053/4 8:35Este2

299Pedido pend.**3/4 8:38Este3

205A tiempo4,300003/8 15:523/4 8:40Este4

250Atrasado6,254173/10 14:483/4 8:42Este5

En la hoja de trabajo, cada fila representa un único pedido de libros. Las columnas incluyen la siguiente información:

• Center: nombre del centro de envío

• Order: fecha y hora del pedido

• Arrival: fecha y hora de la entrega

• Days: tiempo de entrega en días

• Status: estado del envío

◦ On time indica que el envío del libro se recibió a tiempo.

◦ Back order indica que el libro no ha podido enviarse aún porque no está en existencias.

◦ Late indica que el envío del libro se recibió seis o más días después de que se realizara el pedido.

• Distance: distancia desde el centro de envío a la ubicación de entrega

En el siguiente capítulo
Ahora que ya tiene una hoja de trabajo abierta, está listo para empezar a usar Minitab. En el siguiente capítulo, utilizará
gráficos para comprobar la normalidad de los datos y estudiará las relaciones entre las variables.
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2. Hacer gráficos a partir de datos

Introducción
Antes de realizar un análisis estadístico, puede usar los gráficos para examinar los datos y evaluar las relaciones que
existen entre las variables. Además puede usar gráficos para resumir los datos y para ayudar a interpretar los resultados
estadísticos.

Puede acceder a los gráficos de Minitab desde los menús Graph y Stat. Muchos comandos estadísticos disponen también
de gráficos integrados que ayudan a interpretar los resultados y a evaluar la validez de los supuestos estadísticos.

Los gráficos de Minitab incluyen las siguientes funciones:

• Galerías de imágenes para ayudarle a seleccionar un tipo de gráfico

• Flexibilidad para personalizar los gráficos

• Elementos gráficos que puede modificar

• Opción de actualización

Este capítulo explora la hoja de trabajo de datos de envío que abrió en el capítulo anterior. Utiliza gráficos para comprobar
la normalidad de los datos, comparar medias, explorar la variabilidad y estudiar las relaciones entre las variables.

Crear, interpretar y editar histogramas
Antes de realizar un análisis estadístico, primero debe crear gráficos que muestren las características importantes de los
datos. En cuanto a los datos de envío, quiere conocer la media de los tiempos de entrega de cada centro de envío y
cómo los datos varían dentro de cada centro de envío. También quiere determinar si los datos de envío siguen una
distribución normal, de modo que pueda usar los métodos estadísticos estándar para comprobar la igualdad de las
medias.

Crear un histograma en paneles
Para determinar si los datos de envío siguen una distribución normal, cree un histograma en paneles del tiempo transcurrido
entre la fecha de pedido y la fecha de entrega.

1. Si continúa desde el capítulo anterior, vaya al paso 2. De lo contrario, abra el conjunto de datos de muestra,
ShippingData.MTW.
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2. Seleccione Graph > Histogram.

3. Seleccione With Fit y, a continuación, haga clic en OK.

4. En Graph variables, introduzca Días.

5. Haga clic en Multiple Graphs y después en la pestaña By Variables.
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6. En By variables with groups in separate panels, introduzca Centro.

7. Haga clic en OK en cada cuadro de diálogo.

Nota:

Para seleccionar variables en la mayoría de los cuadros de diálogo de Minitab, utilice uno de los siguientes métodos:

• Haga doble clic en las variables del cuadro de lista de variables.

• Resalte las variables en el cuadro de lista y luego haga clic en Select.

• Introduzca los nombres de las variables o los números de columna.

Histograma con grupos en paneles separados

Interpretar los resultados
Los histogramas parecen tener forma acampanada y ser simétricos respecto de las medias, lo que indica que los tiempos
de entrega de cada centro están normalmente distribuidos.
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Reorganizar el histograma dividido en paneles
En el gráfico que ha creado, desea reorganizar los tres paneles para facilitar las comparaciones entre las medias y las
variaciones.

1. Haga doble clic en el histograma para abrir el cuadro de diálogo Editar gráfico.

2. Haga doble clic en cualquiera de los iDe sin el panel en el histograma y seleccione Edit Panels.

3. En la pestaña Arrangement, en Rows and Columns, seleccione Custom. En Rows, introduzca 3. En Columns,
introduzca 1.

4. Haga clic en OK.

Histograma con paneles ordenados en una columna

Interpretar los resultados
Cada centro de envío tiene una media de tiempo de entrega diferente:

• Central: 3,984 días

• Este: 4,452 días

• Oeste: 2,981 días

El histograma muestra que los centros Central y Este son similares en cuanto a la media de tiempo de entrega y a la
dispersión de tiempo de entrega. Por el contrario, la media de tiempo de entrega del centro Oeste es menor y presenta
menos dispersión. Análizar datos en la página 20 muestra cómo detectar diferencias estadísticamente significativas
entre las medias mediante ANOVA (análisis de varianza).

Consejo: Con algunos gráficos y resultados, tales como el histograma, Minitab le notifica cuando cambian datos en la hoja de trabajo. Cuando
los datos cambian, busque la notificación en la parte superior del panel de salida, luego haga clic en uno de los enlaces para actualizar los
resultados o crear nuevos resultados usando los datos actuales.

Editar título y añadir nota a pie de página
Cambie un título y añada una nota a pie de página para que sea más fácil para su supervisor interpretar el histograma.

1. Haga doble clic en el título Histograma de días.
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2. En Text, introduzca Histograma de tiempo de entrega.

3. Haga clic en OK.

4. Haga clic con el botón derecho en el histograma y seleccione Add > Footnote.

5. En Footnote, introduzca Centro Oeste: tiempo de entrega más rápido, la menor variabilidad.

6. Haga clic OK en cada cuadro de diálogo para mostrar los cambios en el panel de salida.
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Histograma con el título modificado y una nueva nota a pie de página

Interpretar los resultados
El histograma en paneles tiene ahora un título más descriptivo y una nota a pie de página que ofrece una breve
interpretación de los resultados.

Crear e interpretar gráficos de dispersión
Los gráficos pueden ayudarle a identificar si existen relaciones entre variables y la fuerza de las relaciones. El hecho de
conocer la relación entre las variables puede ser útil a la hora de determinar qué variables hay que analizar y qué análisis
adicionales seleccionar.

Puesto que cada centro de envío cubre un área regional, sospecha que la distancia hasta el lugar de entrega no repercute
considerablemente en el tiempo de entrega. Para confirmar esta sospecha y eliminar la distancia como posible factor
importante, estudie la relación entre el tiempo y la distancia de entrega para cada centro.

Crear un diagrama de dispersión con grupos
Para examinar la relación entre dos variables se utiliza un diagrama de dispersión. Puede seleccionar un diagrama de
dispersión en el menú de gráficos o puede usar el asistente de Minitab. El asistente puede usarse para la mayoría de
las pruebas estadísticas básicas, así como para los gráficos, los análisis de calidad y el diseño de experimentos (DOE).

Utilice el Asistente en las siguientes situaciones:

• Necesita ayuda para elegir la herramienta correcta para un análisis.

• Quiere cuadros de diálogo con terminología menos técnica y más fáciles de cumplimentar.

• Quiere que Minitab compruebe los supuestos de análisis.

• Quiere resultados más gráficos con explicaciones detalladas sobre cómo interpretar los resultados.

1. Seleccione Assistant > Graphical Analysis.

2. En Relaciones gráficas entre las variables, haga clic en Diagrama de dispersión (grupos).

3. En Y column, introduzca Días.

4. En X column, introduzca Distancia.

5. En Number of X columns, seleccione 1.
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6. En X1, introduzca Centro.

7. Haga clic en OK.

Interpretar los resultados
El Asistente ofrece informes estándar para orientarle durante sus análisis y ayudarle a interpretar los resultados con
confianza.

Informe de resumen
El informe de resumen incluye diagramas de dispersión de días frente a distancias por centro de envío superpuestos
en el mismo gráfico. Este informe también ofrece diagramas de dispersión más pequeños para cada centro de envío.

Informe de diagnóstico
El informe de diagnóstico ofrece orientación sobre posibles patrones en los datos. Los puntos del diagrama de dispersión
no muestran ninguna relación aparente entre días y distancia. La línea de regresión ajustada de cada centro es
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relativamente plana, lo que indica que la proximidad de un lugar de entrega con un centro de envío no repercute en el
tiempo de entrega.

Informe de estadísticas descriptivas
El informe de estadísticas descriptivas contiene estadísticas descriptivas para cada centro de envío.

Tarjeta de informe
La tarjeta de informe proporciona información sobre cómo verificar si existen datos poco comunes. La tarjeta de informe
también indica si hay una posible relación entre la variable Y y las variables X. La variable Y es Days y las variables X
son Distance y Center. Recuerde que el diagrama de dispersión indicaba que no había ninguna relación aparente entre
los días y la distancia. Sin embargo, puede haberla entre los días y el centro de envío, como se estudiará más
detalladamente en el siguiente capítulo, Análizar datos en la página 20.
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Organizar múltiples gráficos en un diseño
Utilice la herramienta de diseño de gráficos de Minitab para organizar varios gráficos en un diseño. Puede añadir
anotaciones al diseño y editar cada gráfico dentro del diseño.

Para mostrar a su supervisor los resultados preliminares del análisis gráfico de los datos de envío, prepare el informe de
resumen y el histograma en paneles en un diseño.

Crear un diseño de gráficos
1. Haga clic con el botón derecho en el informe de resumen y seleccione Layout Tool.

Diseño de gráficos con informe de resumen

Una lista de todos
los gráficos abiertos

Botones usados
para mover
los gráficos a la
composición y
quitarlos de ella

El siguiente gráfico
que se va a mover
a la composición

El informe de resumen que contiene el gráfico de dispersión ya está incluido en el diseño.
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2. Para organizar dos gráficos en una página, en Rows, introduzca 1.

3. Haga clic en el informe de resumen y arrástrelo a la parte derecha del diseño.

4. Haga clic en el botón de flecha a la derecha  para colocar el histograma en paneles en la parte izquierda del
diseño.

5. Haga clic en Finish.

Diseño de gráfico con el histograma en paneles y el diagrama de dispersión

Nota: Si modifica los datos de la hoja de trabajo después de haber creado un diseño, Minitab no puede actualizar automáticamente los
gráficos en el diseño. Deberá volver a crear el diseño con los nuevos gráficos.

Incluir anotaciones en el diseño de gráficos
Quiere añadir un título descriptivo al diseño de gráfico.

1. Haga doble clic en el diseño de gráfico.

2. Para asegurarse de que ha seleccionado todo el diseño de gráfico, haga clic con el botón derecho y seleccione
Select Item > Graph Region.

3. En la barra de herramientas del gráfico, haga clic en Add Item > Title.

4. En Title, introduzca Análisis gráfico de los datos de envío.

5. Haga clic en OK en cada cuadro de diálogo para mostrar los cambios en la panel de salida.
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Diseño de gráfico con un nuevo título

Enviar los resultados a PowerPoint
Para sacarle el máximo partido a sus datos, probablemente le interese comunicar sus resultados a otras personas.
Además, es recomendable proporcionar los resultados junto con explicaciones y otras cifras para ayudar a las personas
a tomar las mejores decisiones. Para compartir sus conocimientos con otros, puede enviar tablas y gráficos directamente
a versiones instaladas localmente de Word, PowerPoint o Companion by Minitab.

• Haga clic con el botón derecho en el gráfico y seleccione Send to PowerPoint.

La presentación de PowerPoint contiene el gráfico.
Nota: Puede enviar cualquier resultado a versiones instaladas localmente de Word, PowerPoint o Companion by Minitab. Para enviar una
gráfico o tabla individuales, haga clic con el botón derecho en el elemento del resultado y seleccione el programa en el cual desea enviar el
resultado. Para enviar el contenido de toda la pestaña de salida, haga clic con el botón derecho en el título en la parte superior de la pestaña.

Guardar un proyecto de Minitab
Los datos de Minitab se guardan en hojas de trabajo. También puede guardar proyectos de Minitab. Cuando guarda un
proyecto, el archivo contiene toda la información sobre su trabajo, que incluye hojas de trabajo, salida, historial de su
sesión y configuración de los cuadros de diálogo.

1. Seleccione File > Save Project As.

2. Vaya a la carpeta en la que quiere guardar los archivos.

3. En File name, introduzca MyGraphs.

4. Haga clic en Save.
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En el siguiente capítulo
El resultado gráfico indica que los tres centros de envío tienen tiempos de entrega distintos para los pedidos de libros.
En el capítulo siguiente, mostrará estadísticas descriptivas y realizará un análisis de varianza (ANOVA) para probar si las
diferencias entre los centros de envío son estadísticamente significativas.
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3. Análizar datos

Introducción
El campo de la estadística ofrece principios y métodos para recopilar, resumir y analizar datos e interpretar los resultados.
Los valores estadísticos se utilizan para describir los datos y hacer inferencias. A continuación, puede usar las interferencias
para mejorar los procesos y productos.

Minitab ofrece muchos análisis estadísticos como la regresión, ANOVA, las herramientas de calidad y las series temporales.
Los gráficos integrados le ayudan a visualizar los datos y a validar los resultados. En Minitab también puede mostrar y
guardar los análisis estadísticos y diagnosticar las mediciones.

Este capítulo evaluará el número de pedidos atrasados y pedidos pendientes y comprobará si la diferencia de los tiempos
de entrega entre los tres centros de envío es estadísticamente significativa.

Resumir los datos
Las estadísticas descriptivas resumen y describen las características principales de los datos. Use Display Descriptive
Statistics para determinar cuántos pedidos de libros se entregaron a tiempo, cuántos llegaron con retraso y cuántos
estaban pendientes inicialmente en cada centro de envío.

Mostrar estadísticas descriptivas
1. Abra los datos de muestra, ShippingData.MTW.

2. Seleccione Stat > Basic Statistics > Display Descriptive Statistics.

3. En Variables, introduzca Días.

4. En By variables (optional), introduzca Estado de centro.

Para la mayoría de los comandos de Minitab, debe completar solo el cuadro de diálogo principal para ejecutar el
comando. A menudo puede usar cuadros de diálogo secundarios para modificar el análisis o mostrar resultados
complementarios, por ejemplo, gráficos.

5. Haga clic en Statistics.

6. Cancele la selección de First quartile, Median, Third quartile, N nonmissing y N missing.
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7. Marque N total.

8. Haga clic en OK en cada cuadro de diálogo.
Nota:  Los cambios que realice en el cuadro de diálogo secundario Statistics solo afectarán a la sesión actual. Para cambiar las opciones
predeterminadas para futuras sesiones, seleccione File > Options. Expanda Individual Commands y seleccione Display Descriptive
Statistics. Seleccione las estadísticas que desee mostrar. Cuando vuelva a abrir el cuadro de diálogo secundario Statistics, este mostrará
las nuevas opciones.

Descriptive Statistics: Days

Results for Center = Central

Total
Variable Status Count Mean SE Mean StDev Minimum Maximum
Days Back order 6 * * * * *

Late 6 6.431 0.157 0.385 6.078 7.070
On time 93 3.826 0.119 1.149 1.267 5.983

Results for Center = Eastern

Total
Variable Status Count Mean SE Mean StDev Minimum Maximum
Days Back order 8 * * * * *

Late 9 6.678 0.180 0.541 6.254 7.748
On time 92 4.234 0.112 1.077 1.860 5.953

Results for Center = Western

Total
Variable Status Count Mean SE Mean StDev Minimum Maximum
Days Back order 3 * * * * *

On time 102 2.981 0.108 1.090 0.871 5.681

Nota: Puede enviar cualquier resultado a versiones instaladas localmente de Word, PowerPoint o Companion by Minitab. Para enviar una
gráfico o tabla individuales, haga clic con el botón derecho en el elemento del resultado y seleccione el programa al que desea enviar el
resultado. Para enviar el contenido de toda la pestaña de resultados, haga clic con el botón derecho en el título del resultado encima de la
línea en la parte superior del panel.
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Interpretar los resultados
El panel de salida muestra los resultados de cada centro por separado. Dentro de cada centro puede ver la cantidad
de pedidos pendientes, pedidos atrasados y pedidos entregados a tiempo en la columna Total Count:

• El centro de envíos Este tiene la mayor cantidad de pedidos pendientes (8) y pedidos atrasados (9).

• El centro de envíos Central está en segundo lugar en cuanto al número de pedidos pendientes (6) y pedidos atrasados
(6).

• El centro de envíos Oeste tiene el menor número de pedidos pendientes (3) y no tiene pedidos atrasados.

La salida también incluye la media, el error estándar de la media, la desviación estándar, el mínimo y el máximo tiempo
de entrega en días para cada centro. Estas estadísticas no existen para los pedidos pendientes.

Comparar dos o más medias
Uno de los métodos usados con mayor frecuencia en el análisis estadístico es la prueba de hipótesis. Minitab ofrece
muchas pruebas de hipótesis, incluidas las pruebas t y ANOVA (análisis de varianza). Por lo general, cuando realiza una
prueba de hipótesis, asume que una afirmación inicial es verdadera, y luego la prueba usando datos de muestras.

Las pruebas de hipótesis incluyen dos hipótesis (afirmaciones): la hipótesis nula (H0) y la hipótesis alternativa (H1). La
hipótesis nula es la afirmación inicial y suele especificarse mediante investigaciones anteriores o un conocimiento general.
La hipótesis alternativa es lo que cree que puede ser verdadero.

De acuerdo con el análisis gráfico que llevó a cabo en el capítulo anterior y el análisis descriptivo que se ha expuesto
arriba, tiene motivos para sospechar que la diferencia en los promedios de días de entrega entre los centros de envío
es estadísticamente significativa. Para verificarlo, realiza un análisis ANOVA de 1 factor que comprueba la igualdad de
dos o más medias. Además, lleva a cabo una prueba de comparación múltiple de Tukey para ver qué medias de los
centros de envío son distintas. Para este análisis ANOVA de 1 factor, los días de entrega es la respuesta y el centro de
envío constituye el factor.

Realizar un análisis ANOVA
1. Seleccione Stat > ANOVA > One-Way.

2. Seleccione Response data are in one column for all factor levels.
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3. En Response, introduzca Días. En Factor, introduzca Centro.

4. Haga clic en Comparisons.

5. En Comparison procedures assuming equal variances, marque Tukey.

6. Haga clic en OK.

7. Haga clic en Graphs.
Para muchos comandos estadísticos, Minitab incluye gráficos integrados que ayudan a interpretar los resultados y a
evaluar la validez de los supuestos estadísticos. Estos gráficos se llaman gráficos integrados.

8. En Data plots, marque Interval plot, Individual value plot y Boxplot of data.
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9. En Residual plots, seleccione Four in one.

10. Haga clic en OK en cada cuadro de diálogo.

One-way ANOVA: Days versus Center

Method

Null hypothesis All means are equal
Alternative hypothesis At least one mean is different
Significance level α = 0.05
Rows unused 17

Equal variances were assumed for the analysis.

Factor Information

Factor Levels Values
Center 3 Central, Eastern, Western

Analysis of Variance

Source DF Adj SS Adj MS F-Value P-Value
Center 2 114.6 57.317 39.19 0.000
Error 299 437.3 1.462
Total 301 551.9

Model Summary

S R-sq R-sq(adj) R-sq(pred)
1.20933 20.77% 20.24% 19.17%

Means

Center N Mean StDev 95% CI
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Central 99 3.984 1.280 (3.745, 4.223)
Eastern 101 4.452 1.252 (4.215, 4.689)
Western 102 2.981 1.090 (2.746, 3.217)

Pooled StDev = 1.20933

Tukey Pairwise Comparisons

Grouping Information Using the Tukey Method and 95% Confidence

Center N Mean Grouping
Eastern 101 4.452 A
Central 99 3.984 B
Western 102 2.981 C

Means that do not share a letter are significantly different.

Interpretar la salida
El proceso de toma de decisiones para una prueba de hipótesis se basa en el valor p, que indica la probabilidad de
rechazar falsamente la hipótesis nula cuando en realidad es verdadera.

• Si el valor p es menor que o igual a un nivel de relevancia predeterminado (denotado por α o alfa), entonces se
rechaza la hipótesis nula y se afirma el apoyo a la hipótesis alternativa.

• Si el valor p es mayor que α, no se rechaza la hipótesis nula y no se puede afirmar el apoyo a la hipótesis alternativa.

Con un nivel de relevancia α igual a 0,05, el valor p (0,000) en la tabla Análisis de varianza proporciona suficiente
evidencia para concluir que los tiempos de entrega promedio de al menos dos de los centros de envío son
significativamente distintos.

Los resultados de la prueba de Tukey se incluyen en la tabla de información de grupo que resalta las comparaciones
significativas y no significativas. Dado que cada centro de envío está en un grupo diferente, todos los centros de envío
tienen tiempos de entrega promedio que son significativamente distintos entre sí.

Interpretar los gráficos de ANOVA
Minitab produce un conjunto de gráficos para ayudarle a interpretar los resultados. Generalmente, primero debe examinar
los gráficos de residuos. Después, examine el gráfico de intervalos, la gráfico de valores individuales y el diagrama de
caja para evaluar la calidad de las medias. Por último, examine el gráfico de intervalo de confianza del 95% de Tukey
para determinar la relevancia estadística.

Interpretar los gráficos de residuos
Use los gráficos de residuos, disponibles con muchos de los comandos estadísticos, para comprobar los supuestos
estadísticos.

Normal Probability Plot
Use este gráfico para detectar la no normalidad. Si los puntos siguen aproximadamente una línea recta, quiere decir
que los residuos se distribuyen normalmente.

Histogram
Use este gráfico para detectar múltiples picos, valores atípicos y desviaciones de la distribución normal. Busque un
histograma normal, que sea aproximadamente simétrico y con forma de campana.
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Versus Fits
Use este gráfico para detectar varianzas no constantes, términos de pedido superior que faltan y valores atípicos.
Busque residuos que estén dispersos aleatoriamente alrededor de cero.

Versus Order
Use este gráfico para detectar la dependencia respecto del tiempo de los residuos. Examine el gráfico para
asegurarse de que los residuos no muestran un patrón evidente.

En cuanto a los datos de envío, los gráficos de residuos cuatro en uno indican la no violación de los supuestos estadísticos.
El modelo ANOVA de 1 factor se adecua a los datos de un modo relativamente correcto.

Nota: En Minitab, usted puede mostrar cada una de los gráficos de residuos en un gráfico separado en la misma ficha.

Interpretar el gráfico de intervalo, el gráfico de valores individuales y el gráfico de caja
Examine el gráfico de intervalos, el gráfico de valores individuales y el gráfico de caja. Cada gráfico indica que el tiempo
de entrega varía según el centro de envío, que es coherente con los histogramas del capítulo anterior. El gráfico de caja
para el centro de envíos Este tiene un asterisco. El asterisco identifica un valor atípico. Este valor atípico en un pedido
que tiene un tiempo de entrega inusualmente largo.

Examine de nuevo el gráfico de intervalos. El gráfico de intervalos muestra intervalos de confianza al 95% para cada
media. Coloque el cursor sobre los puntos del gráfico para ver las medias. Mantenga el cursor sobre las barras de
intervalo para ver los intervalos de confianza del 95%. El gráfico de intervalos muestra que el centro de envío Oeste
tiene el tiempo de entrega medio más rápido (2,981 días) y un intervalo de confianza de 2,75 a 3,22 días.
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Interpretar los gráficos de intervalo de confianza al 95% de Tukey
El gráfico de intervalo de confianza al 95% de Tukey es el mejor gráfico que se puede usar para determinar los rangos
probables de las diferencias y para evaluar el significado práctico de dichas diferencias. Los intervalos de confianza de
Tukey muestran las siguientes comparaciones en parejas:

• La media del centro de envío Este menos la media del centro de envío Central
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• La media del centro de envío Oeste menos la media del centro de envío Central

• La media del centro de envío Oeste menos la media del centro de envío Este

Mantenga el cursor sobre los puntos del gráfico para ver las estimaciones media, superior e inferior. El intervalo de la
comparación del centro Este menos el centro Central es de 0,068 a 0,868. Es decir, el tiempo de entrega medio del
centro de envío Este menos el tiempo de entrega medio del centro de envío Central está entre 0,068 y 0,868 días. Las
entregas del centro de envío Este tardan significativamente más que las entregas del centro de envío Central. Los otros
intervalos de confianza de Tukey se interpretan de forma similar. Observe además la línea discontinua en cero. Si un
intervalo no contiene cero, las medias correspondientes son significativamente distintas. Por lo tanto, todos los centros
de envío presentan unos tiempos de entrega medios significativamente diferentes.

Obtener más información sobre cómo interpretar la salida
Supongamos que quiere obtener más información acerca de cómo interpretar un ANOVA de 1 factor, especialmente el
método de comparación múltiple de Tukey. Minitab proporciona información detallada sobre el resultado de la mayoría
de los comandos estadísticos.

1. Seleccione cualquiera de los resultados de ANOVA de 1 factor.

2. En la barra de herramientas Estándar, haga clic en el botón Help  para obtener más información sobre los resultados
del análisis.

Guardar el proyecto
Guarde todo su trabajo en un proyecto de Minitab.

1. Seleccione File > Save Project As.

2. Vaya a la carpeta en la que quiere guardar los archivos.

3. En File name, introduzca MyStats.

4. Haga clic en Save.

En el siguiente capítulo
La estadística descriptiva y los resultados del ANOVA indican que el centro de envío Western tiene el menor número
de pedidos atrasados y de pedidos pendientes, así como el tiempo de entrega más corto. En el capítulo siguiente, creará

minitab.com 28

Introducción a Minitab 19 para Windows



un gráfico de control y realizará un análisis de capacidad para investigar si el proceso del centro de envío Western es
estable a través del tiempo y capaz de funcionar conforme a las especificaciones.
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4. Evaluar la calidad

Introducción
La calidad es el grado en que los productos o servicios satisfacen las necesidades de los clientes. Las metas comunes
de los profesionales de la calidad incluyen la reducción de las tasas de defectos, la fabricación de productos conforme
a las especificaciones y la estandarización del tiempo de entrega.

Minitab ofrece muchos métodos que ayudan a evaluar la calidad de manera objetiva y cuantitativa. Entre ellos se incluyen
gráficos de control, herramientas de planificación de la calidad, análisis de sistemas de medición (estudios de medición
R&R), capacidad de procesos y análisis de fiabilidad/supervivencia. Este capítulo se centra en los gráficos de control y
la capacidad de los procesos.

Usted puede personalizar los gráficos de control de Minitab de las siguientes maneras:

• Actualizar el gráfico después de añadir o modificar datos.

• Seleccionar cómo calcular los parámetros y límites de control.

• Mostrar las pruebas para causas especiales y etapas históricas.

• Personalizar el gráfico, por ejemplo añadiendo una línea de referencia, cambiando la escala y modificando los títulos,
por ejemplo.

Puede personalizar los gráficos de control cuando los cree o posteriormente.

Con el análisis de capacidad de Minitab, puede hacer lo siguiente:

• Analizar los datos de proceso de muchas distribuciones diferentes, incluyendo normal, exponencial, Weibull, gamma,
Poisson y binomial.

• Mostrar gráficos para verificar que el proceso está bajo control y que los datos siguen la distribución elegida.

Los análisis gráficos y estadísticos realizados en el capítulo anterior muestran que el centro de envío Oeste cuenta con
el tiempo de entrega más rápido. En este capítulo determinará si el proceso del centro de envío Oeste está bajo control
y es capaz de funcionar conforme a las especificaciones.

Crear e interpretar gráficos de control
Los patrones poco comunes en sus datos indican la presencia de variación por causas especiales, es decir, la variación
que no es una parte normal del proceso. Utilice los gráficos de control para detectar variación por causas especiales y
para evaluar la estabilidad del proceso en el tiempo.

Los gráficos de control de Minitab muestran las estadísticas del proceso. Estas estadísticas incluyen las medias de los
subgrupos, observaciones individuales, estadísticos ponderados y números de defectos. Los gráficos de control de
Minitab también muestran una línea central y límites de control. La línea central es el valor promedio del estadístico de
calidad que usted elige evaluar. Si un proceso está bajo control, los puntos variarán de manera aleatoria alrededor de
la línea central. El cálculo de los límites de control se basa en la variación aleatoria esperada en el proceso. El límite de
control superior (LCS) está 3 desviaciones estándar por encima de la línea central. El límite de control inferior (LCI) está
en 3 desviaciones estándar por debajo de la línea central. Si un proceso está bajo control, todos los puntos del gráfico
de control se encuentran entre los límites de control superior e inferior.

Para todas los gráficos de control, usted puede modificar las especificaciones predeterminadas de los gráficos de Minitab.
Por ejemplo, puede definir el método de estimación de la desviación estándar del proceso, especificar las pruebas para
detectar causas especiales y mostrar etapas históricas.
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Crear un gráfico X-barra S
Cree un gráfico X-barra S para evaluar la media y la variabilidad del proceso. Este gráfico de control muestra un gráfico
X-barra y un gráfico S en el mismo gráfico. Use un gráfico X-barra S si sus subgrupos contienen 9 observaciones o más.

Para determinar si el proceso de entrega es estable en el tiempo, el responsable del centro de envío Oeste seleccionó
aleatoriamente 10 muestras para 20 días.

1. Abra los datos de muestra, Quality.MTW.

2. Seleccione Stat > Control Charts > Variables Charts for Subgroups > Xbar-S.

3. Seleccione All observations for a chart are in one column e introduzca Días.

4. En Subgroup sizes, introduzca Fecha.

Para hacer un gráfico de control, solo tiene que completar el cuadro de diálogo principal. Sin embargo, puede hacer
clic en cualquier botón para seleccionar las opciones para personalizar el gráfico.

5. Haga clic en OK.

Gráfico X-barra S

Consejo: Coloque el cursor sobre los puntos de un gráfico o gráfico de control para ver información acerca de los datos.
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Interpretar el gráfico X-barra S
Todos los puntos del gráfico de control están dentro de los límites de control. Por lo tanto, la media y la desviación
estándar del proceso parecen ser estables o estar bajo control. La media del proceso ( ) es 2,985. La desviación estándar
promedio ( ) es 0,631.

Añadir etapas al gráfico de control
Puede usar etapas en un gráfico de control para mostrar cómo cambia un proceso a lo largo de periodos de tiempo
específicos. En cada etapa, Minitab recalcula la línea central y los límites de control.

El responsable del centro de envíos del Oeste aplicó un cambio al proceso el 15 de marzo. Quiere determinar si el
proceso era estable antes y después de este cambio de proceso.

1. Pulse Ctrl+E para abrir el último cuadro de diálogo o seleccione Stat > Control Charts > Variables Charts for Subgroups
> Xbar-S.
Consejo: Minitab guarda los ajustes de su cuadro de diálogo con su proyecto. Para restablecer un cuadro de diálogo, pulse F3.

2. Haga clic en Xbar-S Options.

3. En la pestaña Stages, en Define stages (historical groups) with this variable, introduzca Fecha.

4. En When to start a new stage, seleccione With the first occurrence of these values e introduzca "3/15".

5. Haga clic en OK en cada cuadro de diálogo.

Gráfico X-barra S con etapas

Interpretar los resultados
Todos los puntos del gráfico de control están dentro de los límites de control antes y después del cambio de proceso.
Para la segunda etapa, la media del proceso ( ) es 2,935 y la desviación estándar promedio ( ) es 0,627.

Nota: De manera predeterminada, Minitab muestra los límites de control y las etiquetas de línea central para la etapa más reciente. Para
mostrar las etiquetas de todas las etapas, en el cuadro de diálogo Xbar-S Chart, haga clic en Xbar-S Options. En la pestaña Display, en Other,
seleccione Display control limit / center line labels for all stages.

Añadir más datos y actualizar el gráfico de control
Cuando los datos cambian, puede actualizar cualquier gráfico de control o gráfica (excepto el de tallo y hojas) sin tener
que volver a crear el gráfico.
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Después de crear el gráfico Xbarra-S, el gerente del centro de envíos Oeste le proporciona más datos, que fueron
recopilados el 24/03. Añada los datos a la hoja de trabajo y actualice el gráfico de control.

Añadir más datos a la hoja de trabajo
Debe añadir datos de fecha/hora a C1 y datos numéricos a C2.

1. Haga clic en la hoja de trabajo para activarla.

2. Haga clic en cualquier celda de C1 y pulse la tecla Fin para ir a la parte inferior de la hoja de trabajo.

3. Para añadir la fecha 24/03 a las filas 201 a 210:
a. Introduzca 24/3 en la fila 201 en C1.

b. Seleccione la celda que contiene 24/03 y apunte al control de Relleno automático en la esquina inferior derecha
de la celda. Cuando el puntero se convierta en un símbolo de cruz (+), pulse Ctrl y arrástrelo a la fila 210 para
completar las celdas con el valor de fecha repetido. Cuando mantiene pulsada la tecla Ctrl, aparece una cruz en
superíndice encima del símbolo de la cruz de Llenado automático (++). La cruz en superíndice indica que se
añadirán valores repetidos en lugar de valores secuenciales a las celdas.

4. Añada los siguientes datos a C2, empezando en la fila 201:
3,60 2,40 2,80 3,21 2,40 2,75 2,79 3,40 2,58 2,50

Al introducir los datos, pulse Intro para avanzar a la siguiente celda hacia abajo.

C3C2C1-D

DíasFecha

3,603/241

2,403/242

2,803/243

3,213/244

Nota:  Si la flecha de dirección de introducción de datos  apunta a la derecha, haga clic en la flecha para que apunte hacia abajo.

5. Compruebe que ha introducido los datos correctamente.

Actualizar el gráfico de control
En el panel de salida del gráfico X-barra S, debajo del título del análisis, seleccione Update these results.
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Gráfico X-barra S actualizado que muestra el nuevo subgrupo

El gráfico X-barra S ahora incluye el subgrupo nuevo. La media (  = 2,926) y la desviación estándar (  = 0,607) cambiaron
ligeramente, pero el proceso todavía parece estar bajo control.

Añadir etiquetas de fecha y hora a un gráfico de control
De manera predeterminada, los subgrupos de los gráficos de X-barra S se etiquetan en orden numérico consecutivo.
Puede editar el eje x para mostrar las fechas en su lugar.

1. Haga doble clic en el gráfico.

2. Haga doble clic en el eje x del gráfico X-barra (el gráfico superior).

3. En la pestaña Time, en Time Scale, seleccione Stamp. En Stamp columns (1-3, innermost first), introduzca Fecha.

4. Haga clic en OK.

5. Repita el proceso para el eje x en el gráfico S.

6. Haga clic en OK para actualizar el gráfico en el panel de resultado.
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Gráfico de X-barra S con ejes x modificados

Interpretar los resultados
El eje X de cada gráfico muestra ahora las fechas en lugar de los números de subgrupo.

Crear e interpretar estadísticas de capacidad
Después de determinar que un proceso está bajo control estadístico, desea saber si ese proceso es capaz. Se considera
que un proceso es capaz si cumple las especificaciones y produce buenos resultados y partes. Se determina la capacidad
del proceso mediante la comparación de la dispersión de la variación del proceso con la amplitud de los límites de las
especificaciones.

Importante: No evalúe la capacidad de un proceso que no esté bajo control, porque las estimaciones de la capacidad del proceso podrían
ser incorrectas.

Los índices o los análisis estadísticos de capacidad son una manera sencilla de evaluar la capacidad de los procesos.
Dado que los índices de capacidad reducen la información del proceso a números sencillos, resulta fácil comparar un
proceso con otro.

Realizar un análisis de capacidad
Ahora que sabe que el proceso de entrega está bajo control, realice un análisis de capacidad para determinar si el
proceso de entrega se encuentra dentro de los límites de especificación y produce tiempos de entrega aceptables. El
límite de especificación superior (USL) es 6 porque el responsable del centro de envío Oeste considera que un pedido
llega tarde si se entrega después de 6 días. El responsable no ha establecido un límite de especificación inferior (LSL).
La distribución se aproxima a la normal, de manera que puede utilizar un análisis de capacidad normal.

1. Seleccione Stat > Quality Tools > Capability Analysis > Normal.

2. En Data are arranged as, seleccione Single column. Introduzca Días.

3. En Subgroup size, introduzca Fecha.
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4. En Upper spec, introduzca 6.

5. Haga clic en OK.

Análisis de capacidad del proceso de entrega

Interpretar los resultados
Cpk es una medida de la capacidad potencial del proceso. Ppk es una medida de la capacidad general del proceso.
Tanto Cpk como Ppk son superiores a 1,33, que es el valor mínimo generalmente aceptado. Estas estadísticas indican
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que el proceso del centro de envío Western es capaz y que el centro de envío distribuye los pedidos en un plazo de
tiempo aceptable.

Guardar el proyecto
Guarde todo su trabajo en un proyecto de Minitab.

1. Seleccione File > Save Project As.

2. Vaya a la carpeta en la que quiere guardar los archivos.

3. En File name, introduzca MyQuality.

4. Haga clic en Save.

En el siguiente capítulo
El análisis de calidad indica que el proceso del centro de envío Western está bajo control y es capaz de cumplir los
límites de especificación. En el capítulo siguiente, diseñará un experimento y analizará los resultados para encontrar
maneras de mejorar el proceso de entrega en el centro de envío Western.
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5. Diseño de un experimento

Introducción
El DOE (diseño de experimentos) le ayuda a investigar los efectos de variables de entrada (factores) en una variable de
salida (respuesta) a la vez. Estos experimentos consisten en una serie de ensayos o tests en los que se llevan a cabo
cambios dirigidos en las variables de entrada. En cada ensayo se recopilan datos. Puede utilizar el DOE para identificar
las condiciones de los procesos y los componentes de los productos que repercuten en la calidad y, a continuación,
determinar la configuración de variables de entrada (factores) que optimicen los resultados.

Minitab ofrece cinco tipos de diseños: diseños de cribado, diseños factoriales, diseños de superficie de respuesta,
diseños mixtos y diseños de Taguchi (también llamados diseños robustos de Taguchi). Los pasos a seguir en Minitab
para crear, analizar y visualizar un diseño de experimentos son similares en todos los tipos. Tras haber realizado el
experimento e introducido los resultados, Minitab proporciona varias herramientas de análisis y creación de gráficos que
ayudan a entender los resultados. Este capítulo describe los pasos normales para crear y analizar un diseño factorial.
Puede aplicar estos pasos a cualquier diseño que cree en Minitab.

Los comandos del DOE de Minitab cuentan con las siguientes características:

• Catálogos de diseños de experimentos que le ayudarán a crear un diseño

• Creación y almacenamiento automáticos del diseño una vez especificadas sus propiedades

• Visualización y almacenamiento de los análisis estadísticos de diagnóstico para ayudar a interpretar los resultados

• Gráficos que le ayudarán a interpretar y presentar los resultados

En este capítulo, investigará dos factores que pueden reducir el tiempo necesario para preparar un pedido para su envío:
el sistema de procesamiento de pedidos y el procedimiento de empaquetado.

El centro Western tiene un nuevo sistema de procesamiento de pedidos. Quiere determinar si el nuevo sistema reduce
el tiempo necesario para preparar un pedido. El centro también tiene dos procedimientos de empaquetado distintos.
Desea determinar cuál de ellos es más eficiente. Decide llevar a cabo un experimento factorial para averiguar qué
combinación de factores tiene como resultado el tiempo más corto de preparación de un pedido para su envío.

Crear un experimento diseñado
Antes de introducir o analizar datos de un DOE en Minitab, debe crear un diseño de experimentos en la hoja de trabajo.
Minitab ofrece una variedad de diseños.

Cribado
Incluye diseños de cribado y de Plackett-Burman definitivos.

Factorial
Incluye diseños completos de 2 niveles, diseños fraccionados de 2 niveles, diseños Split-Plot y diseños de
Plackett-Burman.

Superficie de respuesta
Incluye diseños compuestos centrales y diseños de Box-Behnken.

Mezcla
Incluye diseños de centroide simple, diseños de cuadrícula simple y diseños de vértice extremo.

Taguchi
Incluye diseños de 2 niveles, diseños de 3 niveles, diseños de 4 niveles, diseños de 5 niveles y diseños de niveles
mixtos.
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Debe seleccionar el diseño adecuado según los requisitos de su experimento. Seleccione el diseño en el menú
Estadísticas > DOE. Una vez que haya seleccionado el diseño y sus características, Minitab crea el diseño y lo guarda
en la hoja de trabajo.

Consejo: Puede abrir una barra de herramientas para cada tipo de diseño al elegir View > Toolbars.

Seleccionar un diseño factorial para examinar dos factores
Quiere crear un diseño factorial para estudiar la relación entre dos factores, el sistema de procesamiento de pedidos y
el procedimiento de empaquetado y el tiempo necesario para preparar un pedido para el envío.

1. Seleccione File > New > Project.

2. Seleccione Stat > DOE > Factorial > Create Factorial Design.

Cuando crea un diseño en Minitab, solo se activan dos botones, Display Available Designs y Designs. Los demás
botones se activan una vez que se haya cumplimentado el cuadro de diálogo secundario Designs.

3. Haga clic en Display Available Designs.

Para la mayoría de tipos de diseños, Minitab muestra todos los diseños posibles y el número de ensayos experimentales
necesarios en el cuadro de diálogo Display Available Designs.

4. Haga clic en OK para volver al cuadro de diálogo principal.

5. En Type of Design, seleccione 2-level factorial (default generators).
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6. En Number of factors, seleccione 2.

7. Haga clic en Designs.

El área en la parte superior del cuadro de diálogo secundario muestra todos los diseños disponibles para el tipo de
diseño y el número de factores que ha seleccionado. En este ejemplo, debido a que llevará a cabo un diseño factorial
con dos factores, solo dispone de una opción; un diseño factorial completo con cuatro ensayos experimentales. Un
diseño de dos niveles con dos factores tiene 22 (cuatro) combinaciones de factores posibles.

8. En Number of replicates for corner points, seleccione 3.

9. Haga clic en OK para volver al cuadro de diálogo principal.
Todos los botones están ahora activados.

Introducir los nombres de factor y establecer los niveles de factor
Minitab usa los nombres de factor como etiquetas de los factores en los resultados y gráficos del análisis. Si no introduce
niveles de factores, Minitab define el nivel bajo como –1 y el nivel alto como 1.

1. Haga clic en Factors.

2. En la fila de Factor A, en Name, introduzca OrderSystem. En Type, seleccione Text. En Low introduzca Nuevo. En
High introduzca Actual.

3. En la fila de Factor B, en Name, introduzca Paquete. En Type, seleccione Text. En Low, introduzca A. En High,
introduzca B.

4. Haga clic en OK para volver al cuadro de diálogo principal.
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Aleatorizar y guardar el diseño
De manera predeterminada, Minitab aleatoriza el orden de los ensayos de todos los tipos de diseños, excepto el de los
diseños de Taguchi. La selección aleatoria ayuda a garantizar que el modelo cumpla ciertos supuestos estadísticos.
Además, la selección aleatoria puede contribuir a reducir los efectos de factores que no se han incluido en el estudio.

Si define la base para el generador de datos aleatorios, se asegura de que cada vez que cree el diseño obtendrá el
mismo orden de los ensayos.

1. Haga clic en Options.

2. En Base for random data generator, introduzca 9.

3. Verifique que Store design in worksheet se ha seleccionado.

4. Haga clic en OK en cada cuadro de diálogo.

Ver el diseño
Cada vez que cree un diseño, Minitab guardará la información de diseño y los factores en las columnas de la hoja de
trabajo.

1. Haga clic en  la barra de estado para ver más fácilmente la estructura de un diseño típico en la hoja de trabajo.

C7C6-TC5-TC4C3C2C1

PaqueteOrderSystemBloquesCenterPtRunOrderStdOrder

AActual11121

BNueva112112

BActual11343

BNueva11434

ANueva11515

BActual116126

AActual117107

BNueva11878

AActual11969

BActual1110810
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C7C6-TC5-TC4C3C2C1

PaqueteOrderSystemBloquesCenterPtRunOrderStdOrder

ANueva1111511

ANueva1112912

La columna RunOrder (C2) indica el orden de recopilación de datos. Si no aleatoriza el diseño, las columnas StdOrder
y RunOrder serán iguales.

En este ejemplo, dado que no añadió los puntos centrales ni colocó ensayos en bloques, Minitab define todos los valores
de C3 y C4 como 1. Los factores que introdujo se almacenan en las columnas C5 (OrderSystem) y C6 (Pack).

Nota: Puede usar Stat > DOE > Display Design para alternar entre la visualización del orden aleatorio y el orden estándar, así como entre
la visualización codificada y sin codificar. Para cambiar la configuración o los nombres de los factores, use Stat > DOE > Modify Design. Si solo
va a cambiar los nombres de los factores, puede introducirlos directamente en la hoja de trabajo.

Introducir datos en la hoja de trabajo
Después de llevar a cabo el experimento y de haber recopilado los datos, puede introducir los datos en la hoja de
trabajo.

La característica que mide se llama una respuesta. En este ejemplo, usted mide el número de horas necesarias para
preparar un pedido para el envío. El experimento le proporciona los siguientes datos:

14,72 9,62 13,81 7,97 12,52 13,78 14,64 9,41 13,89 13,89 12,57 14,06

1. En la hoja de trabajo, haga clic en la celda de nombre de columna C7 e introduzca Horas.

2. En la columna Hours, introduzca los datos como aparecen a continuación.

C7C6-TC5-TC4C3C2C1

HorasPaqueteOrderSystemBloquesCenterPtRunOrderStdOrder

14,72AActual11121

9,62BNueva112112

13,81BActual11343

7,97BNueva11434

12,52ANueva11515

13,78BActual116126

14,64AActual117107

9,41BNueva11878

13,89AActual11969

13,89BActual1110810

12,57ANueva1111511

14,06ANueva1112912

Puede introducir datos en cualquier columna, excepto las que contengan información de diseño. También puede
introducir varias respuestas para un experimento, una por columna.

Nota: Para imprimir un formulario de recopilación de datos, haga clic en la hoja de trabajo y seleccione File > Print. Verifique que Print Grid
Lines se ha seleccionado. Utilice el formulario para registrar las mediciones durante el experimento.
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Analizar el diseño e interpretar los resultados
Cuando haya creado un diseño e introducido los datos de respuesta, puede ajustar un modelo a los datos y generar
gráficos para evaluar los efectos. Use los resultados del modelo ajustado y los gráficos para determinar qué factores
son importantes para reducir el número de horas necesarias para preparar un pedido para el envío.

Ajustar un modelo
Dado que la hoja de trabajo contiene un diseño factorial, Minitab activa los comandos de menú DOE > Factorial, Analyze
Factorial Design y Cube Plot. En este ejemplo, primero ajustará el modelo.

1. Seleccione Stat > DOE > Factorial > Analyze Factorial Design.

2. En Responses, introduzca Horas.

3. Haga clic en Terms. Compruebe que A:OrderSystem, B:Paquete y AB están en el cuadro Selected Terms.

Cuando analice un diseño, siempre utilice el cuadro de diálogo secundario Terms para seleccionar los términos que
desea incluir en el modelo. Puede añadir o quitar factores e interacciones mediante los botones de flecha. Use las
casillas de verificación para incluir bloques y puntos centrales en el modelo.

4. Haga clic en OK.

5. Haga clic en Graphs.
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6. En Effects Plots, seleccione Pareto y Normal.

Los gráficos de efectos están disponibles solo en diseños factoriales, diseños de cribado y diseños de superficie de
respuesta. Es posible mostrar gráficos de residuos, que son útiles para comprobar los supuestos del modelo, para
todos los tipos de diseños.

7. Haga clic en OK en cada cuadro de diálogo.
Minitab ajusta el modelo que usted ha definido en el cuadro de diálogo secundario Terms, muestra los resultados
en el panel de salida y almacena el modelo en el archivo de hoja de trabajo. Cuando haya identificado un modelo
aceptable, puede usar el modelo almacenado para realizar los análisis siguientes.

Identificar efectos importantes
Puede utilizar tanto las tablas como los dos gráficos de efectos para determinar los efectos que son importantes para
su proceso. Primero, observe las tablas.

Factorial Regression: Hours versus OrderSystem, Pack

Analysis of Variance

Source DF Adj SS Adj MS F-Value P-Value
Model 3 53.894 17.9646 40.25 0.000
Linear 2 44.915 22.4576 50.32 0.000
OrderSystem 1 28.768 28.7680 64.46 0.000
Pack 1 16.147 16.1472 36.18 0.000

2-Way Interactions 1 8.979 8.9787 20.12 0.002
OrderSystem*Pack 1 8.979 8.9787 20.12 0.002

Error 8 3.571 0.4463
Total 11 57.464

Model Summary

S R-sq R-sq(adj) R-sq(pred)
0.668069 93.79% 91.46% 86.02%

Coded Coefficients
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Term Effect Coef SE Coef T-Value P-Value VIF
Constant 12.573 0.193 65.20 0.000
OrderSystem 3.097 1.548 0.193 8.03 0.000 1.00
Pack -2.320 -1.160 0.193 -6.01 0.000 1.00
OrderSystem*Pack 1.730 0.865 0.193 4.49 0.002 1.00

Regression Equation in Uncoded Units

Hours = 12.573 + 1.548 OrderSystem - 1.160 Pack + 0.865 OrderSystem*Pack

Alias Structure

Factor Name

A OrderSystem
B Pack

Aliases

I
A
B
AB

Effects Plot for Hours

Effects Pareto for Hours

Usted ajusta el modelo completo, que incluye los dos efectos principales y la interacción de 2 factores. Los efectos son
estadísticamente significativos cuando sus valores p en la tabla Coeficientes codificados son inferiores a α. En el nivel
predeterminado de α de 0,05, los siguientes efectos son significativos:

• Los efectos principales para el sistema de procesamiento de pedidos (OrderSystem) y el procedimiento de
empaquetado (Pack)

• El efecto de interacción del sistema de procesamiento de pedidos y el procedimiento de empaquetado
(OrderSystem*Pack)

Interpretar los gráficos de efectos
También puede evaluar el gráfico de probabilidad normal y el diagrama de Pareto de los efectos estandarizados para
ver qué efectos influyen en la respuesta, Hours.

Los símbolos cuadrados identifican las condiciones significativas. OrderSystem (A), Pack (B) y OrderSystem*Pack
(AB) son significativas porque sus valores p son inferiores al α de 0,05.
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Minitab muestra el valor absoluto de los efectos en el diagrama de Pareto. Los efectos que se extienden más allá
de la línea de referencia son significativos. OrderSystem (A), Pack (B) y OrderSystem*Pack (AB) son todos significativos.
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Utilizar el modelo almacenado para análisis adicionales
Ha identificado un modelo que incluye los efectos significativos y Minitab ha almacenado el modelo en la hoja de trabajo.
Una marca de verificación en el encabezado de la columna de respuesta indica que un modelo está almacenado y
actualizado. Mantenga el puntero sobre la marca de verificación para ver un resumen del modelo.

C7C6-TC5-TC4C3C2C1

HorasPaqueteOrderSystemBloquesCenterPtRunOrderStdOrder

14,72AActual11121

9,62BNueva112112

13,81BActual11343

7,97BNueva11434

12,52ANueva11515

13,78BActual116126

14,64AActual117107

9,41BNueva11878

13,89AActual11969

13,89BActual1110810

12,57ANueva1111511

14,06ANueva1112912

Puede usar el modelo almacenado para realizar análisis adicionales para entender mejor los resultados. Después, cree
gráficos factoriales para identificar los mejores ajustes de factores y use el análisis Predict de Minitab para predecir el
número de horas para esos ajustes.

Crear gráficos factoriales
El modelo almacenado se utiliza para crear un gráfico de efectos principales y un gráfico de interacción para visualizar
los efectos.

1. Seleccione Stat > DOE > Factorial > Factorial Plots.
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2. Compruebe que las variables, OrderSystem y Paquete estén en el cuadro de diálogoSeleccionado.

3. Haga clic en OK.

Interpretar los gráficos factoriales
Los gráficos factoriales incluyen el gráfico de efectos principales y el diagrama de interacciones. Un efecto principal es
la diferencia en la respuesta media entre dos niveles de un factor. El gráfico de efectos principales muestra la media de
Hours usando tanto los sistemas de procesamiento de pedidos como la media de Hours usando ambos procedimientos
de empaquetado. El diagrama de interacciones muestra el impacto de ambos factores, el sistema de procesamiento de
pedidos y el procedimiento de empaquetado, en la respuesta. Dado que una interacción significa que el efecto de un
factor depende del nivel del otro factor, es importante evaluar las interacciones.

Esta línea muestra
la media de todos
los ensayos del
experimento.

Este punto muestra la media
de todos los ensayos
que usaron el actual
sistema de procesamiento
de pedidos.

Este punto muestra la media
de todos los ensayos que
usaron el nuevo sistema de
procesamiento de pedidos.

Cada punto representa la media de tiempo de procesamiento para un nivel de un factor. La línea central horizontal
muestra el tiempo de procesamiento medio para todos los ensayos. El panel izquierdo del gráfico indica que los pedidos
que se procesaron utilizando el nuevo sistema de procesamiento de pedidos requirieron menos tiempo que los pedidos
que se procesaron utilizando el sistema actual de procesamiento de pedidos. El panel derecho del gráfico indica que
los pedidos que se procesaron usando el procedimiento de empaquetado B tardaron menos que los pedidos procesados
con el procedimiento de empaquetado A.
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Si no hubiese interacciones significativas entre los factores, un gráfico de efectos principales describiría adecuadamente
la relación entre cada factor y la respuesta. Sin embargo, puesto que la interacción sí es significativa, debería examinar
el diagrama de interacciones. Una interacción significativa entre dos factores puede repercutir en la interpretación de
los efectos principales.

La escala vertical (eje y) es en
unidades de respuesta (horas).

Este punto es la media del
tiempo necesario para preparar
paquetes mediante el sistema
de procesamiento de pedidos
nuevo y el procedimiento de
empaquetado A.

La leyenda
muestra los
niveles del
factor, Pack.

La escala horizontal (eje x) muestra los
niveles del otro factor, OrderSystem.

Cada punto del diagrama de interacciones muestra el tiempo de procesamiento medio con diferentes combinaciones
de los niveles de los factores. Si las líneas no son paralelas, el diagrama indica que existe una interacción entre los dos
factores. El diagrama de interacciones indica que los pedidos de libros que se procesaron con el nuevo sistema de
procesamiento de pedidos y el procedimiento de empaquetado B fueron los que menos tardaron en prepararse (9
horas). Los pedidos procesados utilizando el sistema de procesamiento de pedidos actual y el procedimiento de
empaquetado A requirieron el mayor número de horas para su preparación (aproximadamente 14,5 horas). Dado que la
pendiente de la línea correspondiente al procedimiento de empaquetado B es más pronunciada, usted concluye que
el nuevo sistema de procesamiento de pedidos tiene mayor efecto cuando se utiliza el procedimiento de empaquetado
B en lugar del procedimiento de empaquetado A.

A partir de los resultados del experimento, usted recomienda que el centro de envío Oeste use el sistema de
procesamiento de pedidos nuevo y el procedimiento de empaquetado B a fin de acelerar la entrega de pedidos.

Predecir la respuesta
Ha determinado cuáles son los mejores ajustes, que se almacenan en el modelo DOE de la hoja de trabajo. Puede utilizar
el modelo almacenado para predecir el tiempo de procesamiento de estos ajustes.

1. Seleccione Stat > DOE > Factorial > Predict.

2. En OrderSystem, seleccione Nuevo.
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3. En Paquete, seleccione B.

4. Haga clic en OK.

Prediction for Hours
Regression Equation in Uncoded Units

Hours = 12.573 + 1.548 OrderSystem - 1.160 Pack + 0.865 OrderSystem*Pack

Variable Setting
OrderSystem New
Pack B

Fit SE Fit 95% CI 95% PI
9 0.385710 (8.11055, 9.88945) (7.22110, 10.7789)

Interpretar los resultados
El resultado muestra la ecuación del modelo y la configuración de variables. El valor ajustado (también llamado valor
esperado) para estos ajustes es 9 horas. Sin embargo, todas las estimaciones son en cierto modo inciertas ya que usan
datos de muestra. El intervalo de confianza al 95% es la gama de valores probables para el tiempo de preparación media.
Si usa el nuevo sistema de procesamiento de pedidos y el procedimiento de empaquetado B, puede tener un 95% de
confianza en que el tiempo de preparación medio de todos los pedidos estará entre 8,11 y 9,89 horas.

Guardar el proyecto
1. Seleccione File > Save Project As.

2. Vaya a la carpeta en la que quiere guardar los archivos.

3. En File name, introduzca MiDOE.

4. Haga clic en Save.
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En el siguiente capítulo
El experimento factorial indica que es posible reducir el tiempo que se tarda en preparar los pedidos en el centro de
envío Western si se usa el sistema de procesamiento de pedidos nuevo y el procedimiento de empaquetado B. En el
capítulo siguiente, aprenderá a usar el lenguaje de comandos y a crear y procesar archivos ejecutables para poder
repetir rápidamente un análisis cuando se recopilen datos nuevos.
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6. Repetir un análisis

Introducción
Cuando usa un comando de menú en Minitab, Minitab conserva los comandos de sesión que registran sus acciones.
Puede usar estos comandos de sesión para repetir rápidamente un análisis de un nuevo conjunto de datos.

Cada comando de menú tiene un comando de sesión correspondiente. Los comandos de sesión constan de un comando
principal y, por lo general, de uno o más subcomandos. Tanto los comandos como los subcomandos pueden ir seguidos
de una serie de argumentos, que pueden ser columnas, constantes, matrices, cadenas de texto o números. Minitab
ofrece tres maneras de usar los comandos de sesión:

• Introducir los comandos de sesión en el panel Command Line.

• Copiar los comandos de sesión del panel History al panel Command Line.

• Copiar y guardar comandos de sesión en un archivo ejecutable.

Cuando visualiza el panel Command Line/History y luego ejecuta un comando de un menú, los comandos de sesión
correspondientes se muestran en el panel History. Esta técnica ofrece una forma cómoda de aprender los comandos
de sesión.

El centro de envío Oeste recopila y analiza los tiempos de envío de forma continuada, siempre que hay datos nuevos
disponibles. En Evaluar la calidad en la página 30, realizó un análisis de capacidad con los datos de marzo. En este
capítulo usará los comandos de sesión para realizar un análisis de capacidad a partir de los datos de abril.

Realizar un análisis usando comandos de sesión
Una manera de utilizar los comandos de sesión es introducirlos en el panel Command Line. Minitab no muestra el panel
de forma predeterminada, por lo que deberá habilitarlo.

Ver el panel Command Line
1. Si continúa desde el capítulo anterior, seleccione File > New > Project. Si no, inicie Minitab.

2. Abra los datos de muestra, SessionCommands.MTW.

3. Seleccione View > Command Line/History.
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Introducir comandos de sesión
En Evaluar la calidad en la página 30, usted realizó un análisis de capacidad para determinar si los tiempos de entrega
estaban dentro de las especificaciones (menos de 6 días para la entrega). Para realizar este análisis, usó Stat > Quality
Tools > Capability Analysis > Normal. Después introdujo la columna de datos, la columna de subgrupo y el límite de
especificación superior.

A fin de continuar con la evaluación de los tiempos de entrega del centro de envío Oeste, tiene previsto repetir este
análisis de forma periódica. Cuando recopila datos nuevos puede repetir este análisis usando unos cuantos comandos
de sesión.

1. En el panel Command Line, introduzca Capability 'Days' 'Date';
El punto y coma indica que desea introducir un subcomando.

2. Pulse Intro.

3. Introduzca USPEC 6.
El punto indica el final de una secuencia de comandos.

4. Haga clic en Run.
El contenido del panel Command Line no se borra después de que se ejecutan los comandos. Seleccione Clear All
en la parte superior derecha para borrar el contenido del panel.

Análisis de capacidad de los datos de envío del mes de abril
Consejo: Para abrir un archivo PDF que contenga una lista de los comandos de sesión en Minitab, en el panel Command Line, introduzca
Ayuda, luego haga clic en Run.

Copiar comandos de sesión
Minitab genera comandos de sesión para la mayoría de los comandos de menú y los almacena en el panel History.
Puede volver a ejecutar estos comandos seleccionándolos y haciendo clic en Copy to Command Line.

1. En el panel Command Line, haga clic en Clear All.

2. En el panel History, haga doble clic en Capability 'Days' 'Date' para seleccionar el comando y el subcomando.

3. Haga clic en Copy to Command Line.

4. Haga clic en Run.

Análisis de capacidad de los datos de envío del mes de abril
Usted ha vuelto a crear el análisis de capacidad utilizando los comandos del panel History.

Utilizar un archivo ejecutable para repetir el análisis
Un archivo ejecutable es un archivo de texto que contiene una serie de comandos de Minitab. Para repetir un análisis
sin usar los comandos de menú ni los comandos de sesión, guarde los comandos en un archivo ejecutable y a continuación
ejecute el archivo ejecutable.

Crear un archivo ejecutable del panel History
Guarde los comandos de sesión del análisis de capacidad como un archivo ejecutable.

1. En el panel History, haga doble clic en Capability 'Days' 'Date' para seleccionar el comando y el subcomando.

2. Haga clic con el botón derecho en los comandos seleccionados y seleccione Copy.
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3. Abra un editor de texto, como por ejemplo el Bloc de notas.

4. Pegue los comandos en el editor de texto.

5. Guarde el archivo de texto con el nombre y la extensión ShippingGraphs.mtb.

Volver a ejecutar comandos
Puede repetir este análisis ejecutando el archivo ejecutable.

1. Seleccione File > Run an Exec.

2. Haga clic en Select File.

3. Seleccione el archivo ShippingGraphs.MTB y haga clic en Open.

Análisis de capacidad de los datos de envío del mes de abril
Minitab ejecuta los comandos del archivo ejecutable para generar el análisis de capacidad.

Puede ejecutar un archivo ejecutable usando cualquier hoja de trabajo si los nombres de columna coinciden. Así, puede
compartir un archivo ejecutable con otros usuarios de Minitab que quieran realizar el mismo análisis. Por ejemplo, el
responsable del centro de envío Oeste puede compartir ShippingGraphs.MTB con los responsables de otros centros
de envío para que puedan realizar el mismo análisis con sus propios datos. Si desea utilizar un archivo ejecutable con
otra hoja de trabajo o con columnas diferentes, edite el archivo ejecutable utilizando un editor de texto.

Guardar el proyecto
Guarde todo su trabajo en un proyecto de Minitab.

1. Seleccione File > Save Project As.

2. Vaya a la carpeta en la que quiere guardar los archivos.
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3. En File name, introduzca MySessionCommands.

4. Haga clic en Save.

En el siguiente capítulo
Ha aprendido a usar comandos de sesión como una alternativa a los comandos de menú y un modo rápido de repetir
un análisis. En el siguiente capítulo, introducirá datos de múltiples fuentes en una hoja de trabajo. Además, para preparar
los datos y simplificar los análisis, editará los datos y reorganizará columnas y filas.
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7. Importación y preparación de datos

Introducción
A menudo utiliza hojas de trabajo que ya se han creado para su uso. Sin embargo, en ocasiones debe introducir o
importar los datos en una hoja de Minitab antes de iniciar un análisis.

Puede introducir datos en una hoja de trabajo de Minitab de las siguientes maneras:

• Escribir los datos en la hoja de trabajo directamente.

• Copiar y pegar los datos desde otras aplicaciones.

• Importar los datos de archivos de texto o de Microsoft Excel.

Una vez que los datos se encuentren en Minitab, es posible que necesite editar las celdas o reorganizar columnas y
filas para preparar los datos para el análisis. Entre las manipulaciones más comunes de datos se incluyen el apilado, la
creación de subconjuntos, la especificación de nombres de columna y la edición de los valores de los datos.

En este capítulo importará datos a Minitab desde distintas fuentes. También aprenderá cómo se preparó ShippingData.MTW
para el análisis.

Importar datos de distintas fuentes
Para los análisis iniciales en Introducción a Minitab 19, la hoja de trabajo ShippingData.MTW, que contiene datos de tres
centros de envío, ya está configurada. Sin embargo, los tres centros de envío almacenaron originalmente los datos de
envío de las siguientes maneras:

• El centro de envío Este ha almacenado datos en una hoja de trabajo de Minitab.

• El centro de envío Central ha almacenado los datos en una hoja de cálculo de Excel.

• El centro de envío Oeste ha almacenado los datos en un archivo de texto.

Para analizar todos los datos de envío, abra cada archivo en Minitab y después apile los archivos en una hoja de cálculo.

Abrir una hoja de trabajo
Comience con los datos del centro de envío Este.

• Abra el conjunto de datos Eastern.MTW.

Abrir los datos desde una hoja de cálculo de Excel
Los datos del centro de envío Central están en una hoja de cálculo de Excel. Puede abrir archivos de Excel en Minitab.

1. Guarde el conjunto de datos, Central.xlsx.

2. Seleccione File > Open.

3. Vaya hasta la carpeta donde guardó el conjunto de datos.

4. Haga doble clic en Central.xlsx.

5. Haga clic en OK.

Abrir datos desde un archivo de texto (*.txt)
Los datos del centro de envío Oeste estaban en un archivo de texto. Abra el archivo de texto.
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1. Guarde el conjunto de datos Western.txt.

2. Seleccione File > Open.

3. Vaya hasta la carpeta donde guardó el conjunto de datos.

4. Haga doble clic en Western.txt.

5. Haga clic en OK.

Combinar los datos en una hoja de trabajo
Tenga en cuenta que la hojas de trabajo para los centros de envío tienen los mismos nombres de columna. Para facilitar
el análisis de los datos, necesita combinarlos en una hoja de trabajo apilando columnas que tengan los mismos nombres.
Puede mover datos copiando y pegando o usando comandos en el menú Data.

1. Seleccione Data > Stack Worksheets.

2. En Stack option, seleccione Stack worksheets in a new worksheet.

3. Utilice los botones de flecha para mover las tres hojas de trabajo de Available worksheets a Worksheets to stack.

4. En New worksheet name, escriba MyShippingData.

5. Haga clic en OK.

Mover y cambiar nombre de una columna
La columna Origen contiene las etiquetas que identifican datos de los centros de envío. Mueva la columna Origen a C1
y cambie el nombre a Centro.

1. Haga clic en la columna Origen, luego haga clic con el botón derecho y seleccione Move Columns.

2. En Move Selected Columns, seleccione Before column C1.
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3. Haga clic en OK.

4. Haga clic en el nombre de la columna, Origen, introduzca Centro y pulse Intro.

Preparar los datos para su análisis
Ahora que los datos están en una sola hoja de trabajo, puede preparar los datos o manipularlos para que funcionen
para su análisis específico. Por ejemplo, puede volver a codificar los datos o crear una columna de valores calculados.

Consejo: Para obtener más información sobre las manipulaciones de datos en Minitab, vaya a Manipular datos en hojas de trabajo, columnas
y filas, vaya a Manipular datos en hojas de trabajo, columnas y filas.

Recodificar los datos
Las etiquetas de la columna Centro no indican adecuadamente de qué centro proceden los datos. Vuelva a codificar
las etiquetas para eliminar la extensión del archivo.

1. Seleccione Data > Recode > To Text.

2. En Recode values in the following columns, introduzca Centro.

3. En Method, seleccione Recode individual values.

4. En Recoded value, sustituya Eastern.MTW por Este.

5. En Recoded value, sustituya Western.txt por Oeste.
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6. En Storage location for the recoded columns, seleccione In the original columns.

7. Haga clic en OK.

Las etiquetas de la columna Center ahora son Eastern, Central y Western.

Crear una columna de valores calculados
Antes de guardar la nueva hoja de trabajo y realizar los análisis, es necesario calcular el número de días que han
transcurrido entre las fechas de pedido y las de entrega. Puede usar la Calculadora de Minitab para asignar una fórmula
a una columna para calcular estos valores. Si cambia o añade datos, los valores calculados se actualizarán de forma
automática.

Insertar una columna
Inserte una columna entre Arrival y Status.

1. Haga clic en cualquiera de las celdas de C4 para activar esa columna.

2. Haga clic con el botón derecho y después seleccione Insert Columns.

3. Haga clic en la celda de nombre de C4. Escriba Días y, a continuación, pulse la tecla Intro.
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Asignar una fórmula a una columna
Use la calculadora de Minitab para llevar a cabo funciones matemáticas o aritméticas básicas. Minitab guarda los resultados
en una columna o constante. Puede asignar una fórmula a una columna para que los valores calculados se actualicen
automáticamente si los datos cambian.

Calcule el tiempo de entrega y guarde los valores en la columna Days.

1. Seleccione Calc > Calculator.

2. En Store result in variable, introduzca Días.

3. En Expression, introduzca Llegada - Pedido.

4. Seleccione Assign as a formula.

5. Haga clic en OK.

Consejo: También puede añadir una fórmula a una columna haciendo clic con el botón derecho en la columna y seleccionando Formulas
> Assign Formula to Column.

Examinar la hoja de trabajo
La columna Days contiene los valores calculados que representan el tiempo de entrega. Estos valores se expresan en
un número de días. Cuando asigna una fórmula a una columna, aparecerá un indicador de estado en la esquina superior
derecha del encabezado de la columna en la hoja de trabajo. Este indicador especifica si la fórmula se ha definido
correctamente y si es necesario actualizar los datos volviendo a calcular los valores. Una marca de verificación verde 
indica que los datos están actualizados.

C7C6C5-TC4C3-DC2-DC1-T

DistanciaEstadoDíasLlegadaPedidoCentro

255A tiempo4,282643/8 15:213/4 8:34Este1

196A tiempo3,354173/7 17:053/4 8:35Este2

299Pedido pend.**3/4 8:38Este3

205A tiempo4,300003/8 15:523/4 8:40Este4

250Atrasado6,254173/10 14:483/4 8:42Este5
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C7C6C5-TC4C3-DC2-DC1-T

DistanciaEstadoDíasLlegadaPedidoCentro

93A tiempo5,293063/9 15:453/4 8:43Este6

189A tiempo4,050003/8 10:023/4 8:50Este7

335A tiempo5,315973/9 16:303/4 8:55Este8

211A tiempo5,065283/9 10:323/4 8:58Este9

254A tiempo4,285423/8 16:023/4 9:11Este10

Consejo: Coloque el cursor sobre el indicador de estado para ver la fórmula asignada a la columna. Haga doble clic en el indicador de
estado para editar la fórmula.

Cuando los valores de los datos cambian
Supongamos que se da cuenta de que la fecha de llegada de un envío del centro de envío Central es incorrecta. Si
usted corrige la fecha en la hoja de trabajo, Minitab actualiza automáticamente la columna Days, que contiene la fórmula
que calcula el tiempo transcurrido.

Cambie la fecha de llegada en la fila 127.

1. En la columna Arrival, haga clic con el botón derecho y seleccione Find and Replace > Go To, luego introduzca el
número de fila 127.

2. En la celda, cambie 7/3 9:17 a 8/3 9:17.

3. Pulse Intro.

Minitab actualiza automáticamente el valor de la columna Days de 2,98125 a 3,98125.
Nota:  Si prefiere actualizar las fórmulas manualmente, entonces haga clic con el botón derecho en la columna que contiene la fórmula y
seleccione Formulas > Calculate All Formulas Automatically para retirar la selección de esta opción. Si los valores de la hoja de trabajo
cambian de modo que la fórmula de una columna pueda quedar desfasada, el indicador de estado de esa columna cambiará a un triángulo
amarillo. Haga clic con el botón derecho en la columna que contiene la fórmula y seleccione Formulas > Calculate All Formulas Now para
actualizar todas las fórmulas del proyecto.

Guardar la hoja de trabajo
Guarde todo su trabajo en una hoja de trabajo de Minitab.

1. Haga clic en la hoja de trabajo y luego seleccione File > Save Worksheet As.

2. Vaya a la carpeta en la que quiere guardar los archivos.

3. En File name, escriba MyShippingData.

4. En Save as type, seleccione Minitab.

5. Haga clic en Save.
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